
 

 

 

 i 

 
 
 
 

Performance Analysis User Guide  
 
 
 

 



BNH Expert Software 
_______________________________________________________________________________________ 

 

___________________________________________________________________________________________________________ 

    ii | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ADVISOR Enterprise User's Guide 
 
© Copyright 1995 to 2020 BNH Expert Software Inc. 
Latest Update: September 22nd, 2020 
 
All rights reserved. No part of this publication and/or software may be reproduced, stored in a retrieval system or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise without the prior 
written permission of BNH Expert Software Inc., 4000 Steinberg Street, Saint Laurent, Quebec, Canada, H4R 2G7. 
 
Printed in Canada 



BNH Expert Software 
_______________________________________________________________________________________ 

 

___________________________________________________________________________________________________________ 

    iii | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 
 
 

 

Foreword 
 

ADVISOR Enterprise is a Training Management System that drives training efficiency by (a) aligning current and 
future training activities to operational requirements to identify gaps, duplications and training with minimal 
value; (b) forecasting and comparing the costs of viable delivery options; (c) uncovering cost drivers; and (d) 
improving resource allocation.  ADVISOR is built around the ADDIE model with the added flexibility of starting the 
analysis at any level. ADVISOR is made up of the following modules that can be used separately or in any 
combination.  
 

 

Needs 
Assessment 

Assess: To find out “the cause of the problem and potential solutions”.  Provides a step by step approach 
for understanding a problem before selecting the solution – in other words, before assuming that training 
is needed.  Needs Assessment provides an audit trail and serves as the foundation for decisions by zeroing 
in on the source of the problem, identifying solutions that can produce the desired level of productivity, 
and highlighting actions that will generate the greatest impact. [Scope and Needs Assessment]. 
 

Training  
Analysis 

Analysis: To find out “who needs to be trained, on what and why”.  Provides a step by step approach for 
conducting Training Needs Analysis (TNA) or Training Systems Requirements Analysis (TSRA) to identify 
training needed by each job, position and employee to perform duties to the desired standard under the 
prescribed conditions. Four approaches may be used to conduct training analysis, namely Mission, 
System, Competency or Job.  [Mission Analysis, Competency Analysis, System Analysis, Job Task Analysis, 
Knowledge/Skill Gap Analysis and Training Requirements Analysis]. 
 

Training  
Design 

Design: To find out “what is the most effective and economical way to deliver training”.  Provides a step 
by step approach for conducting Training Media Analysis (TMA) or Option Analysis to identify the most 
cost effective strategy for the delivery of training and generates Training Plans.  The analysis takes into 
account limitations, instructional design requirements, upfront and recurring costs over training program 
life as well as risks associated with the introduction of new technology. [Media Analysis, Cost Analysis and 
Training Plans]. 
 

Fidelity  
Analysis 

Develop: To find out the “fidelity requirements of training devices”.  Provides a step by step approach for 
assessing the functional requirements of trainers and simulators based on training needs and 
performance objectives.  It identifies visual, tactile, olfactory, affective and auditory sensory cues needed 
to practice tasks, within realistic environments, under preset conditions to attain the desired level of 
competency.  In addition, ADVISOR takes into account elements within the virtual world and how users 
interact with each. 
 

Resource 
Management 

Implementation: To find out “how much money and resources are needed”. Compiles and analyzes 
missions/goals, competencies, systems, jobs, tasks, training requirements, courses, activities, costs, 
personnel and resources to generate concise, up to date and actionable reports.  The reports provide 
insight on planned training activities for any time period; training requirements for each job/employee; 
budget, personnel and resource requirements, training impact as well as how to drive training 
effectiveness and efficiency by leveraging technology, improving resource allocation and identifying gaps, 
duplications and unwarranted training.  [Forecast and Optimize Training Budgets, Personnel and 
Resources]. 
 

Project 
Management 

Implementation: To find out “how training should be implemented”.  Provides a step by step approach 
for planning a project and tracking progress in real time. This includes the setup of phases and tasks, 
dependencies and constraints, timelines as well as the assignment of personnel and resources needed to 
complete.  Moreover, ADVISOR tracks progress by comparing hours worked and money spent on each 
task to project plan, to anticipate delays, facilitate the implementation of corrective measures, and keep 
projects on-time and within budget. [Develop Project Plans and Track Progress]. 
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Performance 
Analysis 

Evaluation: To find out “how training impacts performance and organizational goals”.  Provides a step by 
step approach for improving performance by zeroing in on the source of the problem and identifying 
solutions that can produce the desired level of productivity.  Moreover, ADVISOR highlights actions that 
will generate the greatest impact by assessing the feasibility of implementing plausible solutions as well 
as forecasting the costs, benefits and Return on Investment (ROI) of each intervention.  [Performance 
Gap Analysis, Root Cause Analysis and Cost Benefit Analysis]. 
 

Training Life 
Cycle 

Management 

Manage: To “continually uncover venues to drive training effectiveness & efficiency”.  Maintains training 
effectiveness and efficiency over time by continually assessing the impact of changes to missions, jobs, 
tasks, systems, policies, technologies, throughput, and so forth on training content and activities; as well 
as budget, personnel and resource requirements. This is attained through a digital-twin model that 
continually aligns training activities to operational requirements to identify gaps, duplications and training 
with minimal value.  Results (personnel/resource requirements for any time period; cost drivers; 
bottlenecks and deficiencies) are quickly and concisely communicated through dashboards.  Actions that 
drive training effectiveness and efficiency are also highlighted.  
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Approach 
 
Why is ADVISOR Enterprise so effective?  Because it focuses on operational requirements – i.e., identifies 
the knowledge, skills and competencies needed by each job, position and employee to attain 
organizational missions/goals, as well as the most efficient way to achieve.  In addition, facts support the 
decision making process, helping you create consensus to stay the course. 
 

Using our proprietary methodology, your efforts unfold in four phases, as follows: 
 

 
 
  

Discover

• Define Missions/Goals.

• Identify Tasks needed by each Job/Position/Employee to attain missions/goals.

• Identify Training requirements.

• Outline current Training Courses/Activities. 

• Find out where money and resources are allocated.

Strategize

• Map Training Courses/Activities to Operational Requirements to identify gaps, 
duplications and unwarranted training. 

• Assesss alternate venues for the delivery of training.

• Uncover resource allocation.

• Uncover cost drivers.

Prioritize

• Prioritize Training Courses/Activities - from highest to lowest impact on 
missions/goals.

• Prioritize recommended changes to current delivery options.

• Identify personnel/resources excess capabilities and bottlenecks.

• Identify strategies for mitigating high cost items.

Optimize

• Develop an implementation strategy starting with low risk, low cost, high 
impact options.

• Align personnel/resources with new strategy.

• Develop project plans and monitor progress.

• Assess and validate results.  
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Performance Analysis 
 

 

ADVISOR Performance Analysis module provides 
a step by step approach for improving 
performance by zeroing in on the source of the 
problem and identifying solutions that can 
produce the desired level of productivity.  
Moreover, ADVISOR highlights actions that will 
generate the greatest impact by assessing the 
feasibility of implementing plausible solutions as 
well as forecasting the costs, benefits and Return 
on Investment (ROI) of each intervention. 

 

 

 
 

 

 

 

  

ADVISOR is a very powerful, useful tool for 
making decisions about which medium is right 

for your organization. A significant contribution 
to the training industry. 

 

Brandon Hall 
Editor, Multimedia and Internet Training 
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ADVISOR Features  ADVISOR Benefits 

Performance Gap Analysis: Assess, compare and 
validate actual missions/goals performance to 
desired performance to identify performance 
gaps. 

 
Speed Data Collection: Collect data from employees, 
supervisors, subject matter experts, etc., offline 
through custom-built questionnaires. Exchange data 
with systems through xml. 

Performance Measures Analysis: Assess the 
financial impact of performance gaps by defining 
performance indicators – i.e., impact on output, 
costs, time and quality. 

 Facilitate Collaboration: Store all data in a 
centralized database accessible anytime and from 
anywhere by team members with only a Browser; and 
track changes made by each individual. 

Job and Performance Analysis: Identify Jobs and 
Tasks that contribute to performance gaps. Assess 
ability to perform to desired standard.  

 Facilitate Reusability: Search, locate and copy 
relevant performance measures from one mission/ 
goal to another with ease. 

Data Required: Highlight data needed to assess 
the cause of the problem. Provide questionnaires 
for collecting data from employees, supervisors, 
subject matter experts, and so forth. 

 
Speed Analysis: Automatically identify Jobs and Tasks 
that may contribute to a performance gap; as well as 
plausible solutions to address performance gaps. 

Root Cause Analysis: Quickly zero in on the root 
cause of a performance deficiency by considering 
crew and supervisors’ feedback, tools, policies and 
work environment to identify viable solutions. 

 Minimize Waste:  Avoid solutions with minimal 
impact on performance deficiency, do not meet 
organizational need or contribute to bottom line – 
i.e., costly decisions based on faulty assumptions. 

Solution Effectiveness Analysis: Assess and rate 
the viability of plausible solutions based on 
compatibility with personnel and infrastructure. 

 Minimize Risk:  Assess personnel receptiveness to 
plausible solutions, solutions compatibility with 
infrastructure, as well as life cycle costs. 

Solution Cost Analysis: Forecast and compare 
costs, personnel and resource requirements of 
viable solutions over program life cycle. 

 Maximize Impact: Prioritize solutions based on 
effectiveness, costs, risk and impact – i.e., where 
budget and resources should be allocated.   

Solution Analysis: Assess the costs, impact and 
return on investment (ROI) of each intervention 
and prioritize recommendations. 

 Speed Report Generation: Produce Performance 
Analysis, Root Cause Analysis, Cost Benefits Analysis, 
and dozens of reports in a single click. 

 

 

 

 

 
 

 

 

 

 
 

  

Very user friendly.  Covers all aspects you should 
consider when making a decision. 

 

Joyce Miligan 
Training Manager, New Brunswick Tel    

BNH delivered as promised. 
 

Col. Eric MacArthur 
Canadian Forces College  
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Chapter 1: Getting Started 
 
 

1.1 Introduction 

 
When faced with a performance deficiency, all too often the focus gravitates towards training as the 
solution.  In most cases, however, performance deficiencies are caused by multiple factors including vague 
expectations, insufficient and untimely feedback, limited access to required information, inadequate 
tools, resources and procedures, inappropriate and counterproductive incentives, and so on.  Moreover, 
it is much easier to fix the environment than people.  To put it in simple terms – if the gap is not due to a 
lack of knowledge and skills, don't train! 
 
Whether you are investigating a performance deficiency or evaluating training impact, the reasons behind 
a performance gap as well as the costs and benefits of plausible solutions should be clearly articulated.  
With accurate, factual data in hand, solutions can be identified; costs and benefits quantified; 
interventions prioritized and action plans formalized to continually improve performance. 
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1.2 How Can ADVISOR Help You?  
 
In addition to simplifying and speeding Training Needs Analysis (TNA) and Training Systems Requirements 
Analysis (TSRA), ADVISOR Enterprise drives training efficiency by aligning current and future training 
activities to operational requirements to identify gaps, duplications and training with minimal value; 
uncovering cost drivers; forecasting and comparing the costs of viable delivery options; improving 
resource allocation; identifying/mitigating bottlenecks; producing training plans that leverage existing 
training programs/resources and generating audit trail to support recommendations.   
 

Moreover, ADVISOR preserves training integrity, effectiveness, efficiency and relevance by quickly 
identifying training activities that could be impacted by a change to a mission, system, job, policy or 
publication; facilitates reusability and collaboration by storing all data in a centralized database that can 
be accessed anytime and from anywhere by all team members with only a browser; simplifies data 
collection from Subject Matter Experts through custom build Excel spreadsheets; speeds data analysis; 
simplifies data manipulation; tracks changes made by each team member; and generates dozens of 
reports in a single click.  ADVISOR is also web based, can be installed on a local Server or used off BNH 
Server (cloud option), consists of 8 modules that can be used separately or in combination to meet various 
needs, and can be customized in line with requirements. 
 

More specifically, follows are ADVISOR “Performance Analysis” module features and benefits.  
 

ADVISOR Features  ADVISOR Benefits 

Performance Gap Analysis: Assess, compare and 
validate actual missions/goals performance to 
desired performance to identify performance 
gaps. 

 
Speed Data Collection: Collect data from 
employees, supervisors, subject matter experts, 
etc., offline through custom-built questionnaires. 
Exchange data with systems through xml. 

Performance Measures Analysis: Assess the 
financial impact of performance gaps by defining 
performance indicators – i.e., impact on output, 
costs, time and quality. 

 Facilitate Collaboration: Store all data in a 
centralized database accessible anytime and from 
anywhere by team members with only a Browser; 
and track changes made by each individual. 

Job and Performance Analysis: Identify Jobs and 
Tasks that contribute to performance gaps. Assess 
ability to perform to desired standard.  

 Facilitate Reusability: Search, locate and copy 
relevant performance measures from one mission/ 
goal to another with ease. 

Data Required: Highlight data needed to assess 
the cause of the problem. Provide questionnaires 
for collecting data from employees, supervisors, 
subject matter experts, and so forth. 

 Speed Analysis: Automatically identify Jobs and 
Tasks that may contribute to a performance gap; as 
well as plausible solutions to address performance 
gaps. 

Root Cause Analysis: Quickly zero in on the root 
cause of a performance deficiency by considering 
crew and supervisors’ feedback, tools, policies and 
work environment to identify viable solutions. 

 

 Minimize Waste:  Avoid solutions with minimal 
impact on performance deficiency, do not meet 
organizational need or contribute to bottom line – 
i.e., costly decisions based on faulty assumptions. 
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Solution Effectiveness Analysis: Assess and rate 
the viability of plausible solutions based on 
compatibility with personnel and infrastructure. 

 Minimize Risk:  Assess personnel receptiveness to 
plausible solutions, solutions compatibility with 
infrastructure, as well as life cycle costs. 

Solution Cost Analysis: Forecast and compare 
costs, personnel and resource requirements of 
viable solutions over program life cycle. 

 Maximize Impact: Prioritize solutions based on 
effectiveness, costs, risk and impact – i.e., where 
budget and resources should be allocated.   

Solution Analysis: Assess the costs, impact and 
return on investment (ROI) of each intervention 
and prioritize recommendations. 

 Speed Report Generation: Produce Performance 
Analysis, Root Cause Analysis, Cost Benefits 
Analysis, and dozens of reports in a single click. 

 

 

 

 
1.3 System Requirements 
 
Database/Server Minimum Requirements 
 2 CPU Processor with 4GB of RAM 
 5 GB of free Hard Disk Space 
 Windows 2000, 2003, 2008, 2012 R2, 2016, 2019, 7, 8, 8.1, 10, NT, or Sun Solaris 9.0 or higher, or 

Linux Red Hat 6.0 or higher 
 Web Server that supports Java Virtual Machine and can run Java Servlet.  Supported products include: 

Tomcat 4.0 or higher, IBM WebSphere 4.0 or higher, Resin, Oracle Application Server, Jserv and 
others… 

 Oracle version 9i, 10g, 11g, 12c, 18c or 19c 
 
Workstation/Desktop Minimum Requirements 
 Pentium IV with 512 MB RAM 
 200 MB of free Hard Disk Space 
 Windows 98, ME, XP, VISTA, 7, 8, 10,  NT, 2000, 2003, 2008, 2012 R2, 2016, 2019 or Oracle Solaris 9.0 

or higher or Linux Red Hat 6.0 or higher 
 Internet Explorer 6.0 or higher, Microsoft Edge, Mozilla Firefox 3.0 or higher, Google Chrome, or Safari 
  

Very user friendly.  Covers all aspects you should 
consider when making a decision. 

 

Joyce Miligan 
Training Manager, New Brunswick Tel    

BNH delivered as promised. 
 

Col. Eric MacArthur 
Canadian Forces College  
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1.4 Background Theory: HPI Process 
 
Human Performance Improvement (HPI) is the systematic process of discovering and analyzing important 
human performance gaps, planning for future improvements in human performance, designing and 
developing cost-effective interventions to close performance gaps, implementing interventions, and 
evaluating financial and non-financial results (Zemke & Kramlinger 1982; Mills 1988; Rummler & Brache 
1995; Gilbert 1996; Kaufman 1996; Pipe & Mager 1999; Harless 2000, and Stolovitch & Keeps 2004).  A 
schematic representation of the HPI process is presented below. 
 
 
                                                                                                                                                         

                                                                                                                                                          
 
 
                                                                                                                                                            
 
 
 
                                                                                                                                                          
 
 
 
 

                                                                                                                                                         
                                                                                                                                                         
 
 
 
 
 
 

For Each                                                                                                                                     
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Step 1 
Problem 
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Plausible 
Solutions 

Step 2 
Business Analysis 

Step 5 
Root Cause 
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Step 7 

Feasibility 
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Step 9 
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Step 4 
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Step 10 
Prioritize Actions 
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Task 

For Each                                                                                                                                     
Solution 



Chapter 1: Getting Started 
____________________________________________________________________________________________ 

 

5 | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 
 
 

 

Step 1. Problem Definition 
 

Define the problem and validate assumptions.  In other words, who initiated the request for analysis or 
training, and for what reason?  Based on circumstantial evidence and constraints, the validity of the 
request can be evaluated, the cost of problem estimated and need for further analysis confirmed. 
 
Step 2. Business Analysis 
 

The minimum (best-case scenario) and maximum (worst-case scenario) monetary impact of the problem 
or opportunity on performance can be estimated.  The business analysis can take into account the impact 
on productivity, costs, time and quality.  
 
Step 3. Job Analysis 
 

Identify potential sources of the problem.  Sources may reside to a varying degree within multiple jobs in 
various units/divisions.  For example, “the unexpected drop in market share may have originated from 
sales, marketing, customer service and support staff”. 
 
 

For Each Job (Occupation) 
 

Step 4. Performance Analysis 
 

Evaluate the ability of each job to adequately perform the Tasks needed to achieve the desired goal.  
Should the evaluation reveal a performance deficiency (i.e., a gap between desired and actual Task 
performance), a root cause analysis may be performed to determine the source of the problem as 
well as plausible solutions.  
 
 

For Each Task 
 

Step 5.  Root Cause Analysis 
  

Collected data is analyzed to uncover factors that impact the performance of each job.  These may 
include employees’ lack of knowledge and skills, misunderstanding of job functions, 
misinterpretation of rules/regulations, access to tools, conflict with colleagues, and so on. 

 
Step 6.  Plausible Solutions 

  

Once the cause of the problem has been uncovered, interventions for each job are identified and 
rated in terms of their potential to bridge the performance gap.  In addition to training and job 
aids, plausible solutions may include task, job and/or organizational redesign, new/improved 
tools, policies/procedures, incentive system and hiring practices. 
 
 

For Each Plausible Solution 
 

Step 7.  Feasibility Analysis 
 

Identify implementation issues. Assess the feasibility and effectiveness of plausible solutions 
by examining the availability of money and resources, compatibility with existing systems, as 
well as management, supervisors and employees’ attitudes towards the proposed solutions. 
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Step 8.  Cost Analysis 
 

Forecast solutions’ costs and potential benefits.  Capture all costs pertaining to each 
intervention, including personnel time, lost opportunity, travel, development, facilities, 
equipment and perpetuation. 
 
Step 9.  ROI Analysis 
 

With costs and potential benefits in hand, anticipated return on investment (ROI) from each 
solution is calculated. 

 
 

Step 10.  Prioritize Actions 
 

Prioritize the recommendations and prepare a plan of action.  The costs and benefits of plausible solutions 
for all jobs are compiled and compared to provide a clear picture of which interventions will generate the 
greatest impact and why. 
 
 

1.5 Getting Started 
 
To log on to ADVISOR Enterprise, go to http://www.bnhexpertsoft.com, click on “Log in”, input your 
Username and Password, and click [Login].  A Popup Window with step by step instructions is presented 
to familiarize you with ADVISOR.  You may change your username, password and preferences by clicking 

on the Preferences node under the Personalize tab, editing the required items and clicking [Save].  For 

example, you may hide or display the Popup Window under the [Options] tab under the Preferences 
node by placing or removing the checkmark next to the ADVISOR Tour field and clicking [Save].  Context 
sensitive online help is also available for each field by clicking on [Help].  
 
 

 
 
To make the most out of ADVISOR Enterprise, Chapters 2 through 6 should be thoroughly reviewed to 
gain clear understanding of the system’s capabilities and how to configure ADVISOR to best meet your 
needs.  For example: 

 
 How to setup/configure Clients in line with project needs; i.e., data to be collected, analysis to be 

conducted and delivery options to be considered? 
 How to setup User Accounts and assign privileges?  
 How quality and consistency should be controlled?  

http://www.bnhexpertsoft.com/
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1.6 How is ADVISOR Organized? 
 
ADVISOR has five main components organized within 3 windows (top, left and right – the sizes of the 
windows can be adjusted by dragging the border). Once you become familiar with these components, the 
system operation and navigation will become fairly simple.  
 
a) Basic Functions (top window) – Actions available to user are presented at the top of the screen.  You 

can Add, Save, Copy, Delete, Merge, Diverge, add comments/assumptions to a screen (Notes), Print a 
screen, Return to previous level (Up), Restore previous values, display context sensitive Help or 
Logout.  Information is only saved when you click [Save]. 

 
b) Path (top window) – Tracks your progress as you navigate through ADVISOR.  
 
c) Tree (left window) – Lists options (nodes) available to user.  To expand an option (node), click on the 

[] icon.  To view the contents of an option (node), click on corresponding node. 
 
d) Tabs (top of right window) – Data for some nodes are divided into several tabs.  Click on tab to view 

its contents. 
 
e) Main Window (right window) – Content of each screen is presented in this window. 
 

 
 

 
 

c 

e 

a 

d 

b 
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1.7 Basic ADVISOR Functions 
 
Add: To add a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Click on corresponding folder (Projects, for example). 
Step 2: Click [Add].   
Step 3: Input the desired info.   
Step 4: Click [Save].   
 
 
 

 
 
 
 
Edit: To edit a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Click on corresponding element (Project A, for example). 
Step 2: Modify the desired info.   
Step 3: Click [Save].   
 
 
  

1 

2 4 

3 
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Delete: To delete a Project, Mission, Job, Task, Objective, Course or any other element: 
Step 1: Place checkmarks next to the desired records (Project Management Office, for example). 
Step 2: Click [Delete].   
 

 
 

 
 
 
 
Track Changes: To find out when an element was created, modified or deleted and by whom, click on the 

View History  icon to display relevant data. 
 

 
 
 
 
  

1 

2 
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Edit Multiple Records: To edit multiple Projects, Missions, Jobs, Tasks, Objectives, Courses or any other 
elements: 
Step 1: Click on the corresponding folder.  
Step 2: Click on the Edit All icon.   
 

 
 
 
The Projects, Missions, Jobs, Tasks, Objectives, Courses, and so forth are presented in an Excel like tabular 
format.  You may sort the data on any column (Title, for example), or lock (prevent the column from 
scrolling), by clicking on the arrow to the right of the column title, and selecting desired option. To edit a 
field, click on the field, input or select option.  Once the desired fields/records are edited, click on [Save] 
to save all changes.  
 

 
 

1 

2 
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Modify Hierarchy: To change the hierarchy or the order of Tasks or Objectives:  
Step 1: Click on the corresponding folder.  
Step 2: Click on the Edit Tree  icon.   
1111 

 
 
 

Tasks or Objectives are presented in a tree like structure. To change the hierarchy or order, simply drag 
and drop the tasks or objectives to the desired locations.  All links to Missions, Jobs, Objectives, Courses, 
etc.; as well as attributes including Knowledge, Skills, Attitudes, References and so forth are preserved. 
For example, “Perform risk analysis” sub task may be dragged under the Tasks folder to become a Task.  
Moreover, all its links and attributes will remain intact. You may also view and edit the attributes of any 
Task or Objective by right clicking on the Task and selecting the Edit option.  Once record is edited, click 
on [Save] button above the record to save; and the [Save Tasks] button to save hierarchy changes.  
 
 
 

 

1 

2 
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Search and Copy:  You can search and copy Jobs, Tasks and Performance Objectives as follows: 
Step 1: Click on the desired folder – Job Analysis, Tasks Analysis or Performance Objectives. 
Step 2: Click on the [Search] tab.   
Step 3: Select the desired search criterion and click [Save] – more options may be provided – to display 

available elements.  
 

 

 

 
 
 

Step 4: Select the desired item to copy data from and click [Save].  
 

 
 

 
 
 

Step 5: Place checkmarks next to the desired elements (Tasks, for example) and click [Save] to copy the 
elements (Tasks) including attributes and sub elements (Sub Tasks).   
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Import Data:  Dozens of Excel Spreadsheets are provided (http://www.bnhexpertsoft.com/data-
collection-forms-configuration-version-12/) to simplify and speed offline data collection from Subject 
Matter Experts (SMEs). The attributes and options within each form (Job Tasks, for example) are identical 
to the corresponding (Job Tasks) fields within ADVISOR. Once completed, the data can be uploaded to 
ADVISOR Enterprise with a few mouse clicks, as follows: 
 

Step 1:  Click on the folder where data should be imported.  Please note that each spreadsheet is designed 
to import data under a specific folder within ADVISOR Enterprise.  For example, the Mission Tasks 
spreadsheet is designed to import Tasks under Missions, while the Job Tasks spreadsheet is 
designed to import Tasks under Jobs. 

  

Step 2: Click on the [Import] tab.   
  

Step 3: Click [Choose File] and select the desired spreadsheet. 
  

Step 4:  Indicate which row to start importing data from, in the Start From Row field.  The top 4 rows in 
ADVISOR Excel spreadsheets are reserved for headings and instructions.  Collected data typically 
starts on the 5th row. 

  

Step 5:  Indicate where the data for each field resides within the Excel spreadsheet.  For example, if Task 
Title is stored in column 1, then input 1; and so forth.  Data in Excel spreadsheets is sequentially 
mapped to corresponding fields in ADVISOR.  You are not required to import all attributes.  For 
example, if the Status and Task Classification attributes are not required, do not input column 
numbers for these fields.  ADVISOR will not import data for attributes that have not been assigned 
a column number. 

  

Step 6: Click [Save] to import.   
 
 

 
 

Note:  Reference Code is also used for detecting duplicate records.  For example, if Job Task is imported, 
ADVISOR will 1st verify whether the Job already has a Task with the same Reference Code.  If it does, the 
following message will appear “Duplicate Records already exist. Overwrite attributes?”  If Ok is selected, 
the attributes of the Job Task in ADVISOR will be updated.  If Cancel is selected, the import will be aborted.  

2 

4 

5 

6 

3 

1 

http://www.bnhexpertsoft.com/data-collection-forms-configuration-version-12/
http://www.bnhexpertsoft.com/data-collection-forms-configuration-version-12/
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Setup and Assign Meta Tags:  To minimize duplication each time a Mission, System or Project Task is 
added, it is stored in a centralized repository.  The Tasks can, in-turn, be assigned to any Mission or System 
by clicking on the [Select] tab, placing checkmarks next to desired Tasks and clicking [Save]. 
   

 
 

 
 
 
Similarly, Knowledge, Skills and Attitudes (KSAs) are stored in a centralized repository and can be assigned 
to any Task or Objective.  
 
To quickly zero in on desired Tasks or KSAs within a repository, Meta Tags can be created under the Project 
Knowledge/Skills Attribute folder and assigned to any Task or KSA by clicking on [Meta Tag] tab, selecting 
the desired Meta Tags and clicking [Save]. 
 
 
 

 
 
 

  

1 

2 

3 

1 

2 

3 



Chapter 1: Getting Started 
____________________________________________________________________________________________ 

 

15 | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 
 
 

 

Specify Items per Page:  By default, 10 items (such as Projects, Tasks, Objectives, Knowledge/Skills, and 
so forth) are displayed on each page.  Once the number of items exceeds 10, the remaining items are 
displayed on subsequent pages.  The number of pages available for each item is indicated on the top right 
as shown below.  To display the items within each page, click on the corresponding page number.  
 

 
 
 
 
You can modify the number of items to be displayed on each page under [Options] tab for the Preferences 
node under the Personalize tab by specifying the number of items to be displayed on each page and 
clicking [Save].  
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1 
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Limit Access to Data/Analysis: By default, when a new Project, Job, Task, and so forth is created, its Status 
is set to Public to permit other Users to find, copy and reuse the Project, Job or Task using the Search 
function and in-turn minimize the effort needed to conduct the analysis.  This does not imply that other 
Users can review and edit your Project, Job or Task.  It simply implies that they can reuse.  To maintain 
anonymity, you can set the Project, Job or Task Status to Private, and in-turn exclude them from the 
Search function. 
 

 
 
 
 
Collaborate with Team:  Each analysis including Project, Course and so forth is assigned to a specific User 
(Manager) – typically the individual that created the Project or Course.  By default, only the Manager can 
view the Project or Course and make changes.  To allow other Users to review and make changes, the 
Project or Course can be shared with them by clicking on the [Sharing] tab, placing checkmarks next their 
name and clicking [Save].  If the Project or Course Manager reports to another User, the Project or Course 
will be automatically shared with them.  In this case, the checkmark next to the Supervisor name is 
presented in read only mode.   
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Add Notes:  Users may add a Note to any screen by clicking on [Notes], typing the note in the new window 
and clicking [Save].  Notes from other Users are presented in read only mode in the bottom of the window.  
Users can only edit or delete their own Notes. 
 
 

 
 
 
 

1.8 Learning ADVISOR 
 
To use ADVISOR, you should know how to perform basic computer, Windows and Browser operations.  
For example, how to start and quit applications, select commands and dialog box options.  To facilitate 
the learning process, ADVISOR comes with its own set of online tools.  These include: 
 

 Online Tour: a slide show that highlights ADVISOR’s main features.  It is presented after User logs on 
ADVISOR.  You can hide and redisplay by unchecking or rechecking the ADVISOR Tour field under the 
[Options] tab, under the Preferences node under the Personalize tab and clicking [Save]. 
 

 Video Clips to gain a better understanding of ADVISOR's main functions and features.   To view, please 
visit the following: http://www.bnhexpertsoft.com/how-to-video-overview/ .  
 

 Step-by-Step Guides for configuring ADVISOR, as well as conducting mission analysis, system analysis, 
competency analysis, job task analysis, media analysis, cost analysis, fidelity analysis, performance 
analysis, etc.  To view and download, please visit the following: http://www.bnhexpertsoft.com/user-
guides-version-12/,    
 

 Answers to Frequently Asked Questions are available online at: http://www.bnhexpertsoft.com/faq-
1-install/.  
 

 Context Sensitive Online Help can be displayed for each screen by clicking on [Help]. Context sensitive 

video clips are also embedded throughout ADVISOR and can be viewed by clicking on the video 
icon.  
 

1 

2 

3 

http://www.bnhexpertsoft.com/how-to-video-overview/
http://www.bnhexpertsoft.com/user-guides-version-12/
http://www.bnhexpertsoft.com/user-guides-version-12/
http://www.bnhexpertsoft.com/faq-1-install/
http://www.bnhexpertsoft.com/faq-1-install/
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 Basic Excel Data Collection Forms for various ADVISOR data elements along with data import 
instructions are available online at: http://www.bnhexpertsoft.com/data-collection-forms-
configuration-version-12/.    
 

 Detailed Excel Data Collection Forms for Project Tasks, System/Competency Tasks and Job Tasks 
along with data import instructions are available online at: http://www.bnhexpertsoft.com/detailed-
data-collection-forms-version-12/ .   
 

 Sample Reports from each module are available online at: http://www.bnhexpertsoft.com/reports/.  
 

 Technical Support:  Available 8:00 am to 6:00 pm EST by calling 1 (514) 745-4010.  You may also fax 
your questions to 1 (514) 745-4011 or E-mail to support@bnhexpertsoft.com. 
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Chapter 2: Define Problem and Impact 
 
 

2.1 Introduction 
 
"I need a training program on ..." is often the opening statement in what turns out to be a costly, 
frustrating and unsuccessful campaign to achieve the desired performance.  The rational for training 
seems clear.  We are implementing a new system, receiving too many complaints from our clients, not 
selling enough products, etc.   
 
Prominent researchers have demonstrated that most performance deficiencies in the workplace are due 
to environmental factors which include vague expectations, insufficient and untimely feedback, limited 
access to required information, inadequate tools, resources and procedures, inappropriate and 
counterproductive incentives, etc.  Yet, when a performance gap occurs, the default intervention is all too 
often training – although it is much easier to fix the environment than people.  To put it in simple terms – 
if the performance gap is not due to a lack of skills and knowledge, don't train!   
  
Even when you determine that training is necessary, is it sufficient?  A training injection on its own, rarely 
works if it is not part of a total performance system.   
 
ADVISOR is a powerful Training Management System (TMS).  It analyzes a performance deficiency, detects 
the source of the problem, identifies solutions – including training – that can produce the desired level of 
productivity and recommends actions to maximize your return on investment (ROI).  ADVISOR is based on 
the published work of several experts in the field of Human Performance Technology including Zemke & 
Kramlinger (1982), Rummler & Brache (1995), Pipe & Mager (1999), Harless (2000), and Weisbord (2002).  
It guides you through the entire needs assessment and ROI process, offers valuable insight on what should 
be taken into consideration and why, and most importantly, it is simple to use.  
 
ADVISOR generates concise charts and tables to effectively communicate the results to others, and 
provides comprehensive reports to support your decision.  With ADVISOR you will never have to wonder 
whether you have made the right choice.  
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To determine how much time and resources should be allocated to a perceived problem/opportunity, the 
scope of the problem/opportunity should first be defined and the assumptions validated.  In other words, 
who initiated the request for the analysis or training, and for what reason?  Based on circumstantial 
evidence and constraints, the validity of the request can be evaluated, the cost of the problem or the 
value of the opportunity estimated and the need for further analysis confirmed.  The minimum (best-case 
scenario) and maximum (worst-case scenario) monetary impact of the problem or opportunity on 
performance can also be projected.    
 
 
Note:  It is assumed that the Project and Missions/Goals are already defined.  If not, please refer to the 
ADVISOR Training Analysis User Guide1 for details on setting up Projects, Missions/Goals, Jobs and Tasks.   
 
 
 
 
  

                                                           
1 http://www.bnhexpertsoft.com/user-guides/  
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2.2 Identify Performance Gaps   
 
To investigate the gaps between desired and actual performance key parameters should 1st be defined 
within a Project.  These would include the Missions/Goals (i.e., what we are trying to achieve), the Tasks 
needed to achieve these Missions/Goals, who is performing each Task, desired outcomes and 
Performance Objectives. If key parameters have not been defined, please refer to ADVISOR Mission 
Analysis Step by Step Guide or ADVISOR Training Analysis User Guide on how to setup.  Once the Project 
and key parameters have been setup, the Project to be investigated can be selected as follows:   
 
Step 1:  Click on the Performance Analysis folder, under the [Evaluate] tab.  
Step 2:  Place checkmark next to the Projects you wish to investigate.  

Step 3:  Click [Save] to create the (project title) node under the Performance Analysis folder. 
 
 

 
 

To identify which Goals are not being met. 

Step 4:  Click on  next to the (project title) node to expand. 

Step 5:  Click on the Mission Evaluations folder. 
Step 6:  Click [Add].   
Step 7:  Input the Evaluation Date, Trigger (i.e., reason for initiating the assessment), Mission/Goal under 

investigation, Actual Performance, Annual Impact, whether the performance gap is significant and 
if monetary (Actual) impact should be estimated using performance indicators.  Data required by 
ADVISOR is identified by a red asterisk (*).  The more data you provide, the better the results. 

Step 8:  Click [Save].   
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The Desired Performance field is automatically populated after you click [Save] from the corresponding 
Mission/Goal Standards field under the Analyze tab. 
 

 
 
 
Notes:   

 

 The Actual Performance should be reported in a similar format to the Desired Performance to 
facilitate the identification of the performance gap. 
 

 If the monetary impact of the problem or opportunity is:  

 Available.  Input the Annual Impact and lock  the value.  
 Not available. The Performance Indicators defined under the Performance Indicators folder 

can be used to estimate the Annual Impact.  In this case: 

 Select Yes for Estimate Monetary Impact field to display the Performance Indicators 

folder and the Summary node under the (mission evaluation) node; and  

 Unlocked  the Annual Impact field to automatically retrieve and report the average 

monetary value computed under the Summary node. 
 

 If the Performance Gap is Acceptable or Not Applicable, then there is no need to carry on further with 
the analysis.  
 

 Each Mission/Goal evaluation can be archived as many times as you need.  Once an analysis is 
archived, changes to the current analysis will not impact data in archived versions.  To archive an 

analysis, click on the (mission/goal title) node, then click on the [Archive] tab, input the Version 
Title and click [Save].  The date on which the archive was created is automatically saved with the 
Version Title.  A list of archived versions is available under the [View] tab.  You may view an archived 
version in read only mode by placing checkmark next to its title and clicking [Save].  You can delete as 
well as recover an archived version (i.e., overwrite existing version) by selecting corresponding 
tabs.  Of course, if an analysis is deleted, all archived versions of the analysis are automatically deleted 
as well.  

  

javascript:window.top.MainScreen.Tree.treeWorkPage.Tabs[0].Tables[0].FastCheckBoxClick(8,"lock")
javascript:window.top.MainScreen.Tree.treeWorkPage.Tabs[0].Tables[0].FastCheckBoxClick(8,"lock")
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Step 9:    To input evidence supporting the current level of performance, click on the [Evidence] tab.  
Step 10:  Input evidence and date. 
 

 
 
Note: 
 Evidence should supplement the initial event that triggered the evaluation.  Evidence may include:  

 Line manager's comments  
 Individual personnel comments  
 Audits or inspections  
 Changes in policies  
 Safety reports  
 Lessons learned reports  
 Unit readiness reports  
 Material readiness reports  
 Introduction of a new piece of equipment  
 Identification of a new or changed competitor  
 Introduction of new job or restructuring of existing job profiles (specialty codes)  

 
 

Step 11:  To input the reliability of collected or examined evidence, click on the [Reliability] tab.  
Step 12:  Input factors considered in assessing the reliability of the evidence. 
 

 
 
Note: 
 The following factors should be considered when evaluating the reliability of formal and informal data:   

 

Formal Reports: 
 Availability of supporting data  
 Sample size and use of statistical procedures  
 Sample size and assumptions related to the scalability of the problem  
 Differing opinions  
 Degree to which report confirms hypothesis  
 Degree to which report confirms other assessments or actions  
 Precision of collected data  
 Reasoning used to draw conclusions  
 Expert's collaboration  

10 
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Informal Data 
 Personal knowledge of individuals providing the data  
 Level of detail  
 Relationship to Task  
 Availability or lack of supporting data  
 Sample size and assumptions related to the scalability of the problem  
 Differing opinions  
 Degree to which data confirms hypothesis  
 Degree to which data confirms other assessments or actions  

 
 
Step 13:  To document problems encountered in collecting data and venues used to overcome difficulties, 

click on the [Difficulties] tab.  
Step 14: Describe difficulties encountered in data collection. 
Step 15: Click [Save]. 
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2.3 Create Performance Measures 
 
To assist analysts in estimating the monetary value of a problem or opportunity, monetary measures can 
be created.  To define a Monetary Measure: 
 

Step 1:  Click on the Performance Indicators folder under the (Project) node. 
Step 2:  Click [Add].   
Step 3:  Input the Performance Measure Title and Formula used to compute the monetary value.   
Step 4:  Click [Save] to create the Performance Indicator. 
 
 

 
 
 

Notes:   
 The Formula should capture how the monetary value of a Performance Measure is computed.  It 

should be written in a generic format to facilitate computations under various scenarios.   
 

 The following operators can be used in composing a formula: "+" [Add], "-" [Subtract], "/" [Divide], 
"*" [Multiple] and "( )" [Group]. 
 

 Each variable in the formula should be presented as one string, i.e., should not include spaces. 
 

 Example #1: The annual monetary value of productivity improvement in a call center may be 
measured as follows:  
 

Calls*DaysPerYear*Employees*Value*Improvement/100 
  

Where:  
 Calls  = Average # of Calls Handled per Employee [per day]  
 DaysPerYear  = Average # of Days an Employee works per Year  
 Employees  = # of Employees that handle calls 
 Value  = Average Monetary Impact/Value [per call]  
 Improvement  = Potential Improvement [%] 
 

 Example #2: The annual monetary impact of improving aircraft inspections may be measured as 
follows:  
 

Inspections*Technicians*Value*Improvement/100 
  

Where:  
 Inspections  = Average # of Inspections Handled per Technician [per year]  
 Technicians  = # of Individuals that Inspect Aircrafts  
 Value  = Average Cost [per inspection]  
 Improvement  = Potential Improvement [%] 
 

By expressing Performance Measures in this format, monetary impact of performance improvement 
can be readily computed, for any size call center or aircraft inspection facility.   

1 
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To provide a brief description for the variables in the formula: 
 

Step 5:  Click on  next to the (Performance Measure) node to expand. 

Step 6:  Click on the Variables node. 
Step 7:  Input the description. 
Step 8:  Click [Save]. 
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2.4 Estimate Monetary Impact of Problem 
 
Performance Measures (Section 2.3) may be used to assess the financial impact of performance 
deficiencies in multiple Missions/Goals.  To estimate the monetary impact of a problem or an opportunity 
on a Mission/Goal: 
 

Step 1: Click on  next to the (Mission Evaluation) node to expand.  

Step 2: Click on the Performance Indicators folder underneath.  
Step 3:  Place checkmarks next to relevant measures (created under Section 2.3) to assess the monetary 

impact of performance deficiency on the Mission/Goal.  
Step 4: Click [Save].  
 

 
 

 
 
 
 
Selected Performance Measures are presented under the Performance Indicators folder.   
 

Step 5:  Click on the (Performance Measure) node to display relevant fields (i.e., variables in Formula). 
Step 6:  Input the required data.  
Step 7: Click [Save] to compute the minimum and maximum monetary impact of this measure on the 

Mission/Goal. 
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Step 8:  Click the Summary node to view the compiled results of all Performance Measures. 
 

 
 
 
The average monetary value [(minimum + maximum) / 2] of all Performance Measures is transferred to 

the Actual Impact field under the (Mission Evaluation) node, if the field is unlocked . 

 
 

Step 9: Click on the (Mission Evaluation) node to view the estimated monetary impact of performance 
deficiency on Mission/Goal.   
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Chapter 3: Evaluate Performance 
 
 

3.1 Introduction 
 
If the problem or opportunity is significant and further analyses are warranted, then the performance of 
individuals that support the Mission/Goal should be investigated.  In other words, are the Tasks that 
directly support the Mission/Goal adequately performed?  For example, “drop in market share” may be 
due to the performance of sales, marketing, customer service and support staff.  Should the evaluation 
reveal a performance deficiency (i.e., a gap between desired and actual Task performance), a root cause 
analysis can be performed to determine the source of the problem and identify plausible solutions.  
 
Note:  It is assumed that Job and Task analyses have already been conducted.  If not, please refer to 
ADVISOR Training Analysis User Guide on how to setup Jobs (Occupations), Tasks and Objectives for each 
Job, as well as indicate their impact on Missions/Goals. 
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3.2 Identify Potential Sources to the Problem 
 

To zero in on the source of the problem, all Performance Objectives (POs) that impact the Mission/Goal 
should be identified along with who is responsible for performing them.  If Job Task Analysis has been 
conducted and POs defined including impact on Mission/Goal (Mission Analysis Step by Step Guide), 
ADVISOR will automatically identify all corresponding Jobs and (POs) that may impact the Mission/Goal. 
Otherwise, you can add Jobs and POs as follows:  
 

Step 1:  Click on the Job Analysis folder.  
Step 2:  Place checkmarks next to relevant Jobs. 
Step 3:  Click [Save] to list selected Jobs under the Job Analysis folder. 
 
 

 

 

 
 
 
 

3.3 Evaluate Tasks Performance 
 

To find out if a gap exists between desired and actual Task performance: 
 

Step 1:  Click on  next to the Job Analysis folder to expand. 

Step 2:  Click on  next to the Job node to expand, and click on the Performance Analysis folder. 
Step 3:  Click [Add].  
Step 4: Input the Evaluation Date, Trigger (i.e., reason for initiating the assessment), Objective (Task) 

under investigation, Actual Performance, whether the Performance Gap is significant and if root 
cause analysis is needed to identify the source of the problem and plausible solutions.   

 
 

 

1 

2 

3 

1 

3

2 

4 2 



Chapter 3: Evaluate Performance 
____________________________________________________________________________________________ 

 

31 | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 

Notes: 
 

 Only POs that have been setup for the Job under the Analysis tab can be investigated. If none have 
been defined, please refer to ADVISOR Mission Analysis Step by Step Guide or Training Analysis User 
Guide on how to conduct Job Task Analysis. 
 

 Once Jobs and POs that impact Missions/Goals have been created, Jobs and POs that impact a specific 

Mission/Goal can be identified by clicking on the Goals Top Down View Report node under the 

Project Reports folder.    
 

 The Actual Performance should be reported in a similar format to the Desired Performance to 
facilitate the identification of the performance gap. 
 

 If the Performance Gap is Acceptable or Not Applicable, then there is no need to carry on further with 
the analysis.  
 

 If the Performance Gap is Significant, then “Yes” should be selected for Perform Root Cause Analysis 

field.  This will in-turn display the Root Cause Analysis folder, the Plausible Solutions node, and 

the Report node under the (objective) node to identify the source of the problem and potential 
solutions. 
 

 Each Performance Analysis can be archived (i.e., preserved) as many times as you need.  Once 
archived, changes to the current analysis will not impact data in archived versions.  To archive an 

analysis, click on the (objective), then click on the [Archive] tab, input the Version Title and click 
[Save].  The date on which the archive was created is automatically saved with the Version Title.   
 

 A list of archived versions is available under the [View] tab.  You may view an archived version in read 
only mode by placing checkmark next to the title and clicking [Save].  You can also delete as well as 
recover an archived version (i.e., overwrite existing version) by selecting corresponding tabs.  Of 
course, if an analysis is deleted, all archived versions of the analysis are automatically deleted as well.  
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Step 5: Click [Save]. The Desired Performance field is automatically populated from the corresponding PO 
Standards field under the Analyze tab. 

 

 
 

 
 
 

Step 6:  To input evidence supporting the current level of performance, click on the [Evidence] tab.  
Step 7:  Input the evidence and date. 
 
 

 
 
 

Note: 
 

 Evidence should supplement the initial event that triggered the evaluation.  Evidence may include:  
 Line manager's comments  
 Individual personnel comments  
 Audits or inspections  
 Changes in policies  
 Safety reports  
 Lessons learned reports  
 Unit readiness reports  
 Material readiness reports  
 Introduction of a new piece of equipment  
 Identification of a new or changed competitor  
 Introduction of new or restructuring of existing job profiles (specialty codes)  
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Step 8:  To input the reliability of collected or examined evidence, click on the [Reliability] tab.  
Step 9:  Input factors considered in assessing the reliability of the evidence. 
 
 

 
 
 
Note: 

 

 The following factors should be considered when evaluating the reliability of formal and informal data:   
 

Formal Reports: 
 Availability of supporting data  
 Sample size and use of statistical procedures  
 Sample size and assumptions related to the scalability of the problem  
 Differing opinions  
 Degree to which report confirms hypothesis  
 Degree to which report confirms other assessments or actions  
 Precision of collected data  
 Reasoning used to draw conclusions  
 Expert's collaboration  
 

Informal Data 
 Personal knowledge of individuals providing the data  
 Level of detail  
 Relationship to Task  
 Availability or lack of supporting data  
 Sample size and assumptions related to the scalability of the problem  
 Differing opinions  
 Degree to which data confirms hypothesis  
 Degree to which data confirms other assessments or actions  
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Step 10:  To document problems encountered in collecting data and venues used to overcome difficulties, 
click on the [Difficulties] tab.  

Step 11:  Describe difficulties encountered in data collection. 
Step 12:  Click [Save]. 
 

 
 

 
 
Note: 
 Repeat this process for each Performance Objective under each Job. 
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Chapter 4: Conduct Root Cause Analysis 
 
 

4.1 Introduction 
 
Should the evaluation reveal a performance deficiency – i.e., a gap between the desired and actual Task 
performance, a root cause analysis should be conducted to determine the source of the problem, which 
may include:  lack of knowledge and skills, misunderstanding of job functions, misinterpretation of rules/ 
regulations, access to tools, conflict with colleagues, and so on – as well as identify and rate plausible 
solutions in terms of their power to bridge the performance gap.  In addition to training and job aids, 
plausible solutions may include task, job and/or organizational redesign, new/improved tools, policies/ 
procedures, incentive system and hiring practices. 
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4.2 Data Collection Methods 
  
Root cause analysis is based on informative clues, much like putting together pieces of a puzzle.  It is very 
helpful in exposing key issues behind a performance deficiency.  Several methods can be utilized to 
acquire the necessary data.  Each method has both advantages and limitations, and in many cases a 
combined methodology may provide the most effective approach to uncover the reasons behind a 
problem.  The following methods of collecting data are suggested for your consideration: 
 

 Individual Interviews – a common tool used to obtain opinions, attitudes and possible causes/ 
solutions for a problem. 
 

 Focus Groups – provide a cost-effective way to secure and circulate information as well as bring 
people onboard when new ideas may be adopted. 
 

 Document Searches – to uncover facts about the current operation that may not surface during 
interviews.  For example, critical incident reports or production figures can provide a good assessment 
of the current situation. 
 

 Observations – of employees on the job can reveal minute and subtle details of performance 
inadequacies or strengths. 
 

 Questionnaires & Surveys – are a less obtrusive way to procure the same information generated by 
other methods.  Moreover, they usually take up less time from participants. 
 

 Nominal Groups – provide a forum for collecting and prioritizing findings about the nature and 
resolution of the problem(s).  

 
 
 

4.3 Data Collection Questionnaires 
  
To facilitate the data collection process, six questionnaires have been provided in Annex A.  The forms 
may be completed during an interview or observation session, or handed out to participants.   
 
Since collected data is required by Root Cause Analysis (Section 4.4), summary forms for each 
questionnaire are also included in Annex A, to assist in compiling data retrieved from multiple 
respondents.  
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4.4 Uncover Plausible Solutions  
 
If the evaluation revealed a performance deficiency – i.e., a gap between desired and actual Task (PO) 
performance, root cause analysis is needed to determine the source of the problem and plausible 
solutions – which may include training, job aids, tools, changes to policies/procedures, and so forth.  To 
initiate the analysis: 
 

Step 1:  Click on  next to the  (objective) node to expand. 
Step 2:  Click on  next to the  Root Cause Analysis folder to display the following eight (8) sections – 

Employees, Supervisors, Feedback, Policies, Tools, Tasks, Environment and 

Recruitment. 
 

Step 3:  Click on the Employees node. 
  

Step 4:  Input Employees’ related data such as [Qualifications] and adequacy of their Knowledge and Skills, 
understanding of [Policies], [Interpersonal Skills], dependency and access to [Tools], quality of 
[Feedback] received, attitude towards [Incentives] systems, and [Job Satisfaction] by clicking on 
the corresponding tabs. 

  

Step 5:  Click [Save]. 
 

 
 

 
 
 
Notes: 

 

 Keep in mind that all questions are related to a specific Performance Objective. 
 

 All fields under Supervisors, Feedback, Policies, Tools, Tasks, Environment and 
Recruitment nodes should also be completed for an accurate assessment of plausible solutions.  
 

 To facilitate data collection, six questionnaires have been provided in Annex A.  The forms may be 
completed during an interview or observation session, or handed out to participants to complete.   
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Step 6: Click on the Plausible Solutions node to view plausible solutions along with rating.   
  

Step 7: To find out why a solution has been proposed, click on the solution title.  The reasons, based on 
information provided, are presented at the bottom of the screen.   

 

 
 
 
Notes: 

 

 You may remove plausible solutions recommended by ADVISOR by setting their impact to blank (null) 

and locking  your selection; or recommending alternate solutions, by indicating their impact and 

locking  your selection.  Click [Save] to update plausible solutions list.    
 

 Plausible solutions may not necessarily be recommended.  Final recommendations take into account 
the feasibility of implementing plausible solutions as well as their cost. 
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4.5 Define Requirements for Plausible Solutions 
 
Should training, job aids, policies/procedures or tools be recommended, the corresponding nodes are 
presented under the Recommended Solutions folder.  Additional details can also be provided for 
Training, Job Aids, Policies and Tools as follows: 
 
4.5.1 Training 
 

If Learning Objectives (LOs) needed to perform the objective have not been defined or there is a need to 
introduce new concepts, you may create new Learning Objectives. To identify training for a plausible 
solution: 
 

Step 1:  Click on  next to the Recommended Solutions folder to expand. 

Step 2:  Click on  next to the Knowledge/Skills Training node to expand. 
Step 3:  Click on the Learning Objectives folder. 
Step 4:  Click [Add].  
Step 5:  Input Title, Reference Code, Length and Learning Outcome. 
Step 6:  Click [Save] to create. 
 

 
 

 
 
 
Note: 
 Learning Objectives provide clear statements of the Knowledge, Skills and Attitudes that individuals 

should possess in order to perform a Task.  Learning Objectives should specify the conditions under 
which Knowledge and Skills should be exhibited and the standard to which it will be performed.    

 
Implications:   
 Learning Objectives can be assigned to Courses needed to develop the Knowledge, Skills and Attitudes 

necessary to perform Tasks at the desired level.  Defining Learning Objectives is therefore critical for 
establishing clear links between training programs, Tasks and Missions/Goals, demonstrating the 
value of various Courses and aligning training with Organization/Units’ Goals. 
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To display existing Learning Objectives for the Solution:   
Step 7:   Click on the [Select Learning Objectives] tab.   
Step 8: Place checkmarks next to desired Learning Objectives – i.e., Learning Objectives needed by 

employees to perform the Task (Objective). 

Step 9:   Click [Save] to display selected Learning Objectives under the Learning Objectives folder. 
 
 

 
 
 
Note: 

 

 [Select Learning Objectives] tab is displayed when Learning Objectives have already been defined 
during training analysis (ADVISOR Enterprise Training Analysis User Guide2). 

 
 
 
  

                                                           
2 http://www.bnhexpertsoft.com/user-guides-version-12/  
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The following function is only available for users with the “Training Analysis” module. 
 
To keep Knowledge and Skills needed to perform various objectives current, Learning Objectives (LOs) 
added to plausible training solutions during Performance Analysis are presented under the Job Analysis.  
To access recommended LOs: 
 
Step 10: Click on the Analyze tab.  

Step 11: Click on  next to the (project) node to expand.  
Step 12: Click on  next to the Job Analysis folder to expand.  

Step 13: Click on  next to the (job) node to expand.  
Step 14: Click on  next to the Performance Objectives folder to expand.  

Step 15: Click on  next to the (objective) node to expand.  

Step 16: Click on  next to the Training node to expand.  
Step 17: Click on the Recommended Learning Objectives folder.  
Step 18: Review Learning Objectives and if appropriate add (copy) recommended Learning Objective to 

the Learning Objectives folder, by placing a checkmark next to the Add to Learning Objectives 
field.  

Step 19: Click [Save].  
 

 
 

 

 
 
 
Notes: 

 

 Once added, recommended Learning Objectives will appear under the Learning Objectives folder,  
and may be edited at that time. 
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4.5.2 Job Aids 
 

To identify Job Aids for a plausible solution: 
 

Step 1:  Click on  next to the Recommended Solutions folder to expand. 

Step 2:  Click on  next to the Job Aids, node to expand. 
Step 3:  Click on the Job Aids folder. 
Step 4:  Click [Add].  
Step 5:  Input Title and Reference Code. 
Step 6:  Click [Save] to create. 
 

 
 

 
 
 
To display existing Job Aids for this Objective:   
Step 7:  Click on the [Select Job Aids] tab.   
Step 8:  Place checkmarks next to desired Job Aids – i.e., Job Aids needed by employees to perform the 

Task (Objective). 

Step 9:  Click [Save] to display selected Job Aids under the Job Aids folder. 
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The following function is only available for users with the “Training Analysis” module. 
 
To keep Job Aids needed to perform various objectives current, Job Aids added to plausible solutions 
during performance analysis are presented under the Job Analysis.  To access recommended Job Aids: 
 
Step 10: Click the Analyze tab.  

Step 11: Click on  next to the (project) node to expand.  

Step 12: Click on  next to the Job Analysis folder to expand.  

Step 13: Click on  next to the (job) node to expand.  
Step 14: Click on  next to the Performance Objectives folder to expand.  

Step 15: Click on  next to the (objective) node to expand.  
Step 16: Click on the Recommended Job Aids folder.  
Step 17: Review Job Aids and if appropriate add (copy) recommended Job Aid to the Job Aids folder, 

by placing a checkmark next to the Add to Job Aids field.  
Step 18: Click [Save].  
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4.5.3 Policies/Procedures 
 

To identify policies/procedures for a plausible solution: 
 

Step 1:  Click on  next to the Recommended Solutions folder to expand. 

Step 2:  Click on  next to the Improve Policies/Procedures to expand. 
Step 3:  Click on the Policies folder. 
Step 4:  Click [Add].  
Step 5:  Input Title and Reference Code. 
Step 6:  Click [Save] to create. 
 

 
 

 
 
 
To display existing Polices for this Objective:   
Step 7:  Click on the [Select Policies/Procedures] tab.   
Step 8: Place checkmarks next to desired Policies/Procedures – i.e., Policies/Procedures needed by 

employees to perform the Task (Objective). 
Step 9:  Click [Save] to display selected Policies/Procedures under the Policies folder. 
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The following function is only available for users with the “Training Analysis” module. 
 
To keep Policies/Procedures needed to perform various objectives current, Policies/Procedures added to 
plausible solutions during Performance Analysis are presented under the Job Analysis. To access 
recommended Policies/Procedures: 
 
Step 10:  Click the Analyze tab.  

Step 11:  Click on  next to the (project) node to expand.  
Step 12:  Click on  next to the Job Analysis folder to expand.  

Step 13:  Click on  next to the (job) node to expand.  
Step 14:  Click on  next to the Performance Objectives folder to expand.  

Step 15:  Click on  next to the (objective) node to expand.  
Step 16:  Click on the Recommended Policies folder.  
Step 17: Review Policies/Procedures and if appropriate add (copy) recommended Policy to the Policy 

folder, by placing a checkmark next to the Add to Policies field.  
Step 18: Click [Save].  
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4.5.4 Tools 
 

To identify tools for a plausible solution: 
 

Step 1:  Click on  next to the Recommended Solutions folder to expand. 

Step 2:  Click on  next to the New Tools to expand. 
Step 3:  Click on the Tools folder. 
Step 4:  Click [Add].  
Step 5:  Input Title and Reference Code. 
Step 6:  Click [Save] to create. 
 

 
 

 
 
 
To display existing Tools for this Objective:   
Step 7:  Click on the [Select Tools] tab.   
Step 8:  Place checkmarks next to desired Tools - i.e., Tools needed by employees to perform the Task 

(Objective). 
Step 9:  Click [Save] to display selected Tools under the Tools folder. 
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The following function is only available for users with the “Training Analysis” module. 
 
To keep Tools needed to perform various objectives current, Tools added to plausible solutions during 
Performance Analysis are presented under the Job Analysis.  To access recommended Tools: 
 
Step 10: Click on the Analyze tab.  

Step 11: Click on  next to the (project) node to expand.  

Step 12: Click on  next to the Job Analysis folder to expand.  

Step 13: Click on  next to the (job) node to expand.  
Step 14: Click on  next to the Performance Objectives folder to expand.  

Step 15: Click on  next to the (objective) node to expand.  
Step 16: Click on the Recommended Tools folder.  
Step 17: Review Tools and if appropriate add (copy) recommended Tool to the Tool folder, by placing 

a checkmark next to the Add to Tools field.  
Step 18: Click [Save].  
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Chapter 5: Analyze Plausible Solutions 

 
 

5.1 Introduction 
 
The viability of plausible solutions can be determined by examining their compatibility with existing 
systems, money and resource requirements as well as management, supervisors and employees’ attitudes 
towards the proposed solutions.  If training solution is needed, two approaches are presented in ADVISOR 
Training Design User Guide for forecasting money and resources.  For all other interventions, the process 
is presented in this Chapter. With costs and potential benefits in hand, anticipated return on investment 
(ROI) from each training program and solution can be calculated. 
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5.2 Setup Plausible Solutions 
 
Plausible solutions viability can be determined by examining compatibility with existing systems, money 
and resource requirements as well as management, supervisors and employees attitudes towards the 
proposed solutions.  With costs and potential benefits in hand, anticipated return on investment (ROI) 
from each solution can be calculated.  Training solutions are setup under the Design tab (for details, please 
refer to the Training Design User Guide or Media Analysis Step by Step Guide).  Non-training solutions are 
setup under the Solutions tab.  To setup a non-training solution: 
 

Step 1:  Click on the Solutions tab.  
Step 2:  Click on Solutions folder.  
Step 3:  Click [Add].   
Step 4:  Input general information, such as Solution Title, Solution Type, Expected Life, etc.  Data required 

by ADVISOR is identified by a red asterisk (*).  Of course, the more data you provide, the better 
the results.   

Step 5:  Click [Save] to create the Solution. 
 
 
 

 
  
 

Notes:   
 

 Each solution can be archived as many times as you need.  Once archived, changes to the current 

analysis will not impact data in archived versions.  To archive an analysis, click on the (solution 
title) node, then click on the [Archive] tab, input the Version Title and click [Save].  The date on which 
the archive was created is automatically saved with the Version Title.  
 

 A list of archived versions is presented under the [View] tab. You may view an archived version in read 
only mode by placing checkmark next to its title and clicking [Save].  You can delete as well as recover 
an archived version (i.e., overwrite existing version) by selecting corresponding tabs.  Of course, if a 
solution is deleted, all archived versions of the solution are automatically deleted as well.  
 

 You may also share your analysis with colleagues (i.e., Users assigned to the same Client) by clicking 
on the Sharing tab, placing checkmarks next to their names and clicking [Save].  
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You may specify data to be collected and analyses to be conducted for each Solution under the [Analysis 
Required] tab.  By default, the Requirements setup under Client are automatically selected. Moreover, 
Analysis Requirements for the Solution will be automatically updated as Client’s Requirements change, if 
the cascade function is set to on       .  To override Analysis Requirements set under the Client, turn off the 
cascade function off       . To restore the Analysis Requirements of the Client turn cascade back on        and 
click [Save].  
 
 

 
 
Note: 

 

 By indicating which data and analyses are needed, ADVISOR will automatically hide nodes, tabs and 
fields that are no longer relevant, and in-turn streamline data collection and reduce time required to 
conduct the analysis – a very effective way of configuring ADVISOR to better meet your needs. 
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Step 6:  Click on  next to the (solution title) node to expand. 

Step 7:  Click on the Options node. 
Step 8:  Input the title for each option.  
Step 9:  Click [Save].   
 
 
 

 
 
 
 

5.3 Define Target Audience 
 
If Jobs (Occupations) have been defined under the Analyze tab under the Job Analysis folder, a  
Target Audience folder will appear.  To select the Target Audience for this solution: 
 

Step 1: Click on the Target Audience folder. 
Step 2: Place checkmarks next to appropriate Jobs. 
Step 3: Click [Save]. 
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To associate the current Solution with a plausible solution (identified under the Plausible Solutions 

node under an (objective), Section 4.4) – in other words to indicate that this Solution will close the 
identified performance gap for this Job: 
 
Step 4: Click on  next to the Target Audience folder to expand. 
Step 5: Click on  next to the (Selected Target Audience) folder to expand. 

Step 6: Click on the Link Solution to Performance Gap node. 
Step 7:  Select relevant Solutions. Only Plausible Solutions that match current Solution Type are presented. 
Step 8: Click [Save].   
 

 
 

 
 
 
To indicate the number of individuals that require this solution: 
 

Step 9:   Click on the Individuals per Year node.  
Step 10: Input the number of individuals that require this solution for each year. 
Step 11: Click [Save].   
 

 
 

 
 
Notes: 

 

 If required, the projections can be refined further by indicating the number of individuals that require 
the Solution in each month by selecting the Months option under Estimate Number of Employees in 

field under the (solution) node.   
 

 Changes are automatically tracked by ADVISOR including who made the change and when.  History of 

Changes Report can be generated by clicking the History icon  in the top right corner.   
  

4 7 

8 

9 10 

11 

6 

javascript:top.MainScreen.Tree.Click(top.MainScreen.Tree.topnode.kids[0].kids[0].kids[3].kids[4])


Chapter 5: Analyze Plausible Solutions 
____________________________________________________________________________________________ 

 

54 | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 

5.4 Assess the Effectiveness of Plausible Solutions 
 
To assess the viability of plausible solutions: 
 

Step 1:  Click on  next to Feasibility Analysis folder to display the following sections: Management, 

Employees, Supervisors, and Resources.   

Step 2:    To indicate management awareness and support to Solutions, click on the Management node. 
Step 3:   Complete applicable fields.   
Step 4:   Click [Save].  
 
 
 

 
 
 
Note: 

 The same process can be repeated for Employees, Supervisors and Resources nodes. 
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To view the effectiveness of plausible solutions: 
 

Step 5:  Click on the Effectiveness node. 
Step 6:  Click on the Solution Title to find out why a solution is not recommended or why its effectiveness 

has been reduced.  The reasons, based on information provided, are presented at the bottom of 
the screen.   

 

 
 
 
Note: 

 

 A 100% rating indicates a perfect match - i.e., the proposed Solution is well aligned with management, 
employees, supervisors and organizational needs/expectations.  A 0% rating indicates that the 
proposed Solution does not meet one or more critical requirements.   

 
 
 

5.5 Interpret Feasibility Analysis Results 
 

Although the Feasibility Analysis model is based on hard evidence and scientific principles, keep in mind 
that the rating is an indicator – rather than an exact measurement.  In other words, the primary objective 
of the Feasibility Analysis is to assist the analyst in identifying which solution best meets management, 
employees, supervisors and organizational needs.  Moreover, it provides the reasoning behind the 
recommendations, so you are fully aware of the limitations of each solution.  With this in hand, decisions 
can be made with a high degree of confidence on which option will best meets your needs.  
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5.6 Forecast the Costs of Plausible Solutions 
 
The costs of design, development, hardware, software, administration, management, maintenance and 
support of plausible solutions are computed in this section.  Moreover, costs can be classified as Direct 
(budget related) or Indirect (resources/productivity related).   
 
In general, the costs can be divided into six main groups, namely:  Development, Hardware, Software, 
Administrative, Management and Support.  The costs can be further classified into two main categories – 
one time (start-up) or recurring (annual) costs.  A brief description of items included in each group is 
presented below.  
  
 

Group Description Classification 

Development 
 Analyze/Design/Develop Solution  
 Purchase/License Off-the-Shelf Solution 
 Formative Evaluation (Pilot) 

Start-up 
Start-up 
Start-up 

   

Hardware 
 Purchase Hardware 
 Set-up/Install Hardware 
 Equipment Operation Cost 

Start-up 
Start-up 
Annual 

Software 
 Purchase Software 
 Set-up/Install Software 
 Software Maintenance Cost 

Start-up 
Start-up 
Annual 

   

Administrative  Staff (coordinate the implementation of solution) Annual 

Management  Staff (coordinate solution analysis, design, acquisition, 
development, support and maintenance) 

Annual 

   

Support 

 Consumable Materials 
 Maintenance Costs 
 Staff (installation, resolving software and hardware 

problems, etc.)   

Annual 
Annual 
Annual 

 
 

 
 
Note:   

 

 ADVISOR can be configured for each Client in line with needs by specifying data to be collected and 

analyses to be conducted under the Setup tab, by clicking Clients Setup folder, selecting the  
(client) node, and clicking the [Analysis Required] tab (Chapter 2, ADVISOR Configuration Guide3).   

 

                                                           
3 http://www.bnhexpertsoft.com/user-guides-version-12/  
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For your reference, the process and formulas used to compute the costs are presented below.   
 
 

5.6.1 Basic Variables 
 

Item Example Comments 

Annual Productive Days 230 # of days an average employee works per 
year. 

Working Hours per Day  8.0  

 
 
 

5.6.2 Development Costs 
 

Item Example Comments 

Total Development Time [hours] 560 Estimate the effort required to design and 
develop the proposed solution. 

Average Daily Cost for Developer $500  
Total Personnel Costs $35,000 = (560 / 8) x $500 
   

Unit Cost of Off-The-Shelf Solution $0 Only relevant if off-the-shelf solution exists. 
Number of Items Requires 0 Only relevant if off-the-shelf solution exists. 
Total Cost of Off-The-Shelf Solution $0 = $0 x 0 
   

Contracting Costs  $2,000  
Master Copy Production $5,000  
Evaluation Costs $12,000  
Miscellaneous Costs $1,000  
   

Total Development Costs $55,000 = $35,000 + $0 + $2,000 + $5,000+ $12,000 + 
$1,000 
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5.6.3 Hardware Costs 
 

Purchase 
  

Item Example Comments 

Number of Units 25  
Cost per Unit $10,000  
Sub Total Hardware Costs $250,000 = 25 x $10,000 
   

Availability [hours per year] 50,000 (2,000 hours per year per unit x 25 units) 
Internal Set-up & Miscellaneous Costs $5,000  
External Set-up & Miscellaneous Costs $2,000  
Total Hardware Costs $257,000 = $250,000 + $5,000 + $2,000 
   

Solution Allocation [%] 50% If the equipment or hardware is shared among 
several solutions, then the cost should be 
divided among these solutions. 
 

ADVISOR computes Solution Allocation as 
follows: 
Number of Hours Equipment Used [per year] 
(25,000) / Availability (50,000 hours) 
 

You may override & lock  these values. To 

restore recommended value, unlock  and 
click [Save]. 

   

Hardware Cost for Solution $128,500 = $257,000 x 50% 

 
 
Operation 
 

Item Example Comments 

Cost of Equipment Operation [per hour] $2  
Number of Hours Equipment Used [per year] 25,000  
Solution Allocation [%] 50% Retrieved from Purchase Costs.   
Total Cost of Equipment Operation [over life] $75,000 = $2 hour x 25,000 hours x 3 years x 50% 
   

Annual Equipment Maintenance Costs $12,500  
Total Equipment Maintenance Costs [over life] $18,750 = $12,500 x 3 years x 50% 
   

Total Equipment Operation Costs [over life] $93,750 = $75,000 + $18,750 
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5.6.4 Software Costs 
 

Purchase 
  

Item Example Comments 

Number of Units 25  
Cost per Unit $1,000  
Sub Total Software Costs $25,000 = 25 x $1,000 
   

Internal Set-up & Miscellaneous Costs $7,000  
External Set-up & Miscellaneous Costs $8,000  
Total Software Costs $40,000 = $25,000 + $7,000 + $8,000 
   

Solution Allocation [%] 50% If the software is shared among several 
solutions, then the cost should be divided 
among these solutions. 

   

Software Cost for Solution $20,000 = $40,000 x 50% 

 
 
Maintenance 
 

Item Example Comments 

Annual Software Maintenance Cost [per unit] $150  
Solution Allocation [%] 50% If the software is shared among several 

solutions, then the cost should be divided 
among these solutions. 

   

Total Software Maintenance Costs [over life] $5,625 = $150 x 25 x 3 years x 50% 
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5.6.5 Administrative Costs 
 

Item Instructor-led Comments 

Annual Salary of Administrative Staff $40,000  
Fringe Benefits Factor [%] 30% Covers employees’ benefits as well as general 

operational (overhead) expenses. 
Annual Cost $52,000 = $40,000 x 130% 
   

Annual Productive Days 230 Number of days an average employee works 
per year. 

Daily Cost $226 = $52,000 / 230 
   

Days on Project [per year] 15 Estimate number of administrative days for 
coordinating the implementation of solution.  

Annual Personnel Costs $3,390 = $226 x 15 
   

Annual Miscellaneous Costs $500  
   

Total Administrative Costs [over life] $11,670 = [$3,390 + $500] x 3 years Life of Solution 

 
 
 

5.6.6 Management Costs 
 

Item Instructor-led Comments 

Annual Salary of Management Staff $65,000  
Fringe Benefits Factor [%] 40% Covers employees’ benefits as well as general 

operational (overhead) expenses. 
Annual Cost $91,000 = $65,000 x 140% 
   

Annual Productive Days 220 Number of days an average employee works 
per year. 

Daily Cost $414 = $91,000 / 220 
   

Days on Project [per year] 45 Estimate number of management days for 
Solution. Includes coordinating development, 
delivery, support, evaluation, maintenance, 
etc.  

Annual Personnel Costs $18,630 = $414 x 45 
   

Annual Miscellaneous Costs $1,500  
   

Total Management Costs [over life] $60,390 = [$18,630 + $1500] x 3 years Life of Solution 
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5.6.7 Support Costs 
 

Maintenance  
 

Item Instructor-led Comments 

Material Cost [per individual] $50 Consumable material. This may include 
workbooks, notepads, handouts, CDs, etc. 

Total Material Costs $15,000 = $50 x 300 (Number of Employees) 
   

Total Development Cost $55,000 Retrieved from Section 5.6.2 Development 
Costs 

Revision Factor 20% % of revision proposed solution would 
require per year. 

First Year Maintenance Costs Exclude  
Total Revision Costs [over life] $22,000 = [$55,000 x 20%] x 2 years 
   

Annual Miscellaneous Costs $3,200  
   

Total Maintenance Cost [over life] $46,600 = $15,000+ $22,000 + [$3,200] x 3 (Life of 
Solution)  

 

 
Technical Support  
 

Item Instructor-led Comments 

Annual Salary of Support Staff $50,000  
Fringe Benefits Factor [%] 35% Covers employees’ benefits as well as general 

operational (overhead) expenses. 
Annual Cost $67,500 = $50,000 x 135% 
   

Annual Productive Days 230 Number of days an average employee works 
per year. 

Daily Cost $293 = $67,500 / 230 
   

Days on Project [per year] 75 Estimate number of days required from 
support staff.  Includes installing, changing 
configuration, trouble shooting, etc.  

Annual Personnel Costs $21,975 = $293 x 75 
   

Annual Miscellaneous Costs $1,500  
   

Total Support Costs [over life] $70,425 = [$21,975 + $1500] x 3 years Life of Solution 
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5.6.8 Total Costs 
 

Item Instructor-led Comments 

Development Costs $55,000  
Hardware Costs $128,500  
Hardware Operation Costs $93,750  
Software Costs $20,000  
Software Maintenance Costs $5,625  
Administrative Costs $11,670  
Management Costs $60,390  
Maintenance Costs $46,600  
Support Costs $70,425  
Total Costs $491,960 = $55,000 + $128,500 + $93,750 + $20,000 + 

$5,625 + $11,670 + $60,390 + $46,600 + 
$70,425 

   

Total Number of Employee 300 That require the Solution. 
Cost per Trainee $1,640  
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5.7 Compute the Costs of Plausible Solutions 
 
To compute the costs of plausible solutions, including design, development, hardware, software, 
administrative, management, maintenance and support costs:  
 

Step 1:  Click on  next to Cost Analysis folder to display the following nodes: Basic Variables, 

Development, Hardware, Software, Administrative, Management, and Support. 

Step 2:  Click on the Development node. 
Step 3: Input relevant data.  You do not have to complete all fields; but of course, the more data you 

provide the better the results. 
Step 4:  Click [Save] to automatically compute costs based on inputs. 
 

 
 

 
 
 
Notes:   

 

 Similar process can be used to forecast and compute Hardware, Software, Administrative, 

Management, and Support costs, as needed. 
 

 To classify a cost as Direct (out of pocket expense) or Indirect (personnel/resource required), click on 

the or  button next to the field to toggle between the two.   
 

 Clarification for each field as well as the impact of the response on the results can be viewed by clicking 
on [Help].   
 

 Data can only be entered in active cells.  Data from previous entries or results are presented in read 
only mode. To change the value of a read only cell, Total Personnel Costs, for example, you would 
have to edit the fields used to compute this value, namely Total Development Time [hours] or 
Average Daily Cost for Developer.  
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Step 5: Click on the Summary node to view a detailed breakdown of the costs of plausible Solutions 
over Solution life (including inflation), present value, as well as the cost per employee, under the 
[Distribution] tab. 

  

Step 6: To view [Direct] (out of pocket) costs, [Indirect] (personnel/resource related) costs, [Upfront]4 and 
[Recurring] costs as well as [Personnel] and [Resources] required to design, develop, administer, 
maintain and support the solution, click on the corresponding tabs. 

 
 

 
 
 

  

                                                           
4 Upfront or startup costs represent the initial monetary outlay to launch the Solution. 
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ADVISOR automatically Rates plausible Solutions from most to least favorable.  For each option, key data 
is presented, including: Rating (how well did the Solution meet management, employees, supervisors and 
organizational needs), Direct Up-front and Recurring Costs, as well as required Resources (i.e., Developers 
and Administrators).  To view the Ratings for plausible Solutions: 
 

Step 7:  Click on next to the Summary folder to expand. 

Step 8:  Click on the ADVISOR Recommendations node. 
Step 9:  Click on the solution title, to find out why the Rating of a solution has been reduced.  The reasons, 

based on information provided, are presented at the bottom of the screen.   
 

 
 
 
Once you have examined the effectiveness and costs of plausible solutions, you can select the option that 
best meets your needs, as follows: 
 

Step 10:  Click on the User Recommendation node. 
Step 11: Select the desired Solution. 
Step 12: Click [Save]. 
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ADVISOR automatically calculates the Return on Investment (ROI) of User Recommended Solution based 
on its projected impact on relevant Objectives, Tasks and in-turn unit/organization Missions/Goals.  To 
view the ROI: 
 

Step 13:  Click on the Projected ROI node. 
 

 
 
 
Note:   
 

 In addition to forecasting and comparing the costs of plausible Solutions, the Cost Analysis module 
provides insight on how funds and resources are allocated.  For example, how much funds are 
required to develop a Solution or purchase the necessary hardware; how many working days will be 
required to support employees, etc.  You may also run what if scenarios such as developing Solution 
internally versus externally, for example, to determine impact on budget and resources. 
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Chapter 6: Generate Reports 

 
 

6.1 Generate Solution Report 
 
A comprehensive business case report that documents the process used to rate the effectiveness and 
compute the costs of plausible Solutions can be generated as follows: 
 

Step 1:  Click on the Solution Report node. 
Step 2:  Select items to be included. 
Step 3:  Click [Save].   
 

 
 

 
 
The report is presented in html format, in a new window. You may print or save the report using the 
corresponding functions in your Browser.  Since the report is in html format, you can quickly advance to 
any section by clicking on the corresponding title in the Table of Contents.  
 

Step 4:  To generate the report in Word click on [Generate Word Doc] button.  
Step 5:  To return to ADVISOR, close the Solution Report window.  
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6.2 Identify Actions Needed to Meet Goals 
 
To identify interventions (training and non-training Solutions) needed to meet current, emerging and 
future challenges (i.e., achieve Missions/Goals) including impact, costs, benefits and Return on Investment 
(ROI).  The interventions can be identified for a specific Mission/Goal or a specific Task (Performance 
Objective) for a particular Job.  To generate report: 
 

Step 1:  Click on the Reports tab; click on  next to the Maximize Training Impact [Effectiveness & 

Efficiency] folder to expand; and click on the Identify Actions Needed to Meet Goals folder. 
Step 2:  Click [Add].   
Step 3:  Input the Report Title, Report Type (i.e., Mission or Job Profile), Client that the report is assigned 

to, as well as the Project under investigation.   
Step 4:  Click [Save] to advance to the next screen.  
 
 

 
 

Note:   
 All Users assigned to a Client may use the same parameters to generate their own reports.  However, 

only data accessible to the User will be compiled and presented.  Data accessible to the User is limited 
to: Jobs (including Tasks, Performance/Enabling Objectives and Knowledge/Skills) managed by User, 
Jobs managed by Subordinates (i.e., individuals that report to User including their subordinates) as 
well as Jobs in sub-divisions that User has access to. 
 

Step 5:  Place checkmarks next to the required Missions/Goals or Job Tasks, to identify actions needed to 
attain the Mission/Goal or Job Task. 

Step 6:  Click [Save] to generate.   
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The report is presented in a new window.  You may export the report to other file formats such as MS 
Word, PDF, or print by clicking on the corresponding icon in the top left corner of the screen.  To return 
to ADVISOR, close the Report window.  

 

 
Recommended Solutions that have not been analyzed are dimmed.  To find out the costs, impact, benefits 
and return on investment (ROI) of a plausible Solution, click on corresponding title Job Aids for example. 
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6.3 Identify Training Needed to Meet Goals 
 
Identifies training needed to close a performance gap, or meet current, emerging and future challenges.  
The impact of plausible training Solutions as well as costs, benefits and Return on Investment (ROI) are 
also presented.  To generate report: 
 
Step 1:  Click on the Reports tab. 
Step 2:  Click on  next to the Maximize Training Impact [Effectiveness & Efficiency] folder to expand. 
Step 3:  Click on the Identify Training Needed to Meet Goals folder. 
Step 4:  Click [Add].   
Step 5:  Input the Report Title, Report Type (i.e., Mission or Job Profile), Client that the report is assigned 

to, as well as the Project under investigation.   
Step 6:  Click [Save] to advance to the next screen.  
 

 
 

 
 
 
Step 7:  Place checkmarks next to the required Missions/Goals or Job Tasks, to identify training needed to 

meet goals. 
Step 8:  Click [Save] to generate.   
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The report is presented in a new window.  You may export the report to other file formats such as MS 
Word, PDF, or print by clicking on the corresponding icon in the top left corner of the screen.  To return 
to ADVISOR, close the Report window. 
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6.4 Forecast Interventions Impact & ROI for Organization Report 
 
Forecasts potential Return on Investment (ROI) of non-training interventions by comparing anticipated 
impact on Missions/Goals to costs.  To generate report: 
 
Step 1:  Click on the Reports tab. 
Step 2:  Click on  next to the  Maximize Training Impact [Effectiveness & Efficiency] folder to expand. 
Step 3:  Click on the Forecast Interventions Impact & ROI for Organization folder. 
Step 4:  Click [Add].   
Step 5:  Input Report Title, select By (Client, User or Solution) and the Client that the report is assigned to. 
Step 6:  Click [Save] to advance to the next screen.  
 

 
 

 
 
 
Step 7: Specify the time period, i.e., the Start and End Dates, and select Solutions to be included in the 

Report. 
Step 8: Click [Save] to generate the report. 
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The report is presented in a new window.  You may export the report to other file formats such as MS 
Word, PDF, or print by clicking on the corresponding icon in the top left corner of the screen.  To return 
to ADVISOR, close the Report window.  
 

 
 
 
Recommended Solutions that have not been analyzed are dimmed.  To find out the costs, impact and 
benefits of a plausible Solution, click on corresponding title Policies for example. 
 

 
 
 
 
Remember that context sensitive help is also available for each screen by clicking on [Help] and video clips 

on how to perform specific functions by clicking on the  icon.    Enjoy! 
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Annex A: Data Collection Forms 
 

 
Employees Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions: Read each statement carefully and place checkmark in column that represents your response.  If the 
statement does not apply to you, please leave the space blank. Thank you. 
 

Employees Questionnaire Disagree 
Slightly 

Disagree 
Agree 

Aware of Policies    

I can list all policies and procedures that relate to the Task    

I understand the reasons behind all policies and procedures relating to Task    

I am supportive of existing policies and procedures for this Task    

I can describe the level of performance expected of me for this Task    

I can explain how my performance is evaluated/measured for this Task    

Get Along with Colleagues    

I require help or additional resources from fellow employees in order to perform 
this Task 

   

I get along quite well with co-workers and superiors    

My performance of this Task is not diminished by the relations I have with my 
supervisor/manager 

   

Need for Tools    

The tools and/or materials that I depend on to perform this Task are readily 
available 

   

Receive Adequate Feedback    

Formal procedure is in place to provide me feedback on my performance    

Constructive feedback is offered on working relationships with colleagues    
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Employees Questionnaire (continued) Disagree 
Slightly 

Disagree 
Agree 

Motivated by Incentive System    

I am motivated by the long-term incentives offered for meeting expectations    

The system for delivering reprimands is constructive, fair and improves 
productivity 

   

There are clear short-term incentives for achieving the expected level of output    

Short-term rewards encourage me day by day to be more productive    

Enjoy my Job    

The work I carry out is gratifying and makes a difference for those around me and 
beyond 

   

I am given too much work on a regular basis, which reduces the quality I can 
provide 

   

Attitude Towards Supervisor    

My supervisor brings out the best in me    

If I need guidance and support from my supervisor, he/she is seldom available to 
provide advice 

   

Attitude Towards Feedback    

The information I receive about the Task performance allows me to accurately 
adjust my actions 

   

The level of performance expected of me for this Task, and how to achieve it is 
clear  

   

Feedback on this Task is given in time to allow me to make improvements     

Constructive feedback on how to get along with others is provided regularly     

Advice I receive on interactions with others indicates what is acceptable behavior    

Feedback is given in a timely manner to enable me to maintain acceptable 
behavior 

   

Attitude Towards Task    

I find that the Task challenging and it maintains my interest    
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Employees Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
 
Directions:  Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result 
in the corresponding field in the Root Cause Analysis (Section 4.4). 
     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

I can list all policies and procedures that relate to the Task 2 0 8 Agree 

I understand the reasons behind all policies and procedures relating to 
Task 

    

I am supportive of existing policies and procedures for this Task     

I can describe the level of performance expected of me for this Task     

I can explain how my performance is evaluated/measured for this Task     

I require help or additional resources from fellow employees in order to 
perform this Task 

    

I get along quite well with co-workers and superiors     

My performance of this Task is not diminished by the relations I have 
with my supervisor/manager 

    

The tools and/or materials that I depend on to perform this Task are 
readily available 

    

Formal procedure is in place to provide me feedback on my 
performance 

    

Constructive feedback is offered on working relationships with 
colleagues 

    

I am motivated by the long-term incentives offered for meeting 
expectations 

    

The system for delivering reprimands is constructive, fair and improves 
productivity 

    

There are clear short-term incentives for achieving the expected level of 
output 
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Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

Short-term rewards encourage me day by day to be more productive     

The work I carry out is gratifying and makes a difference for those 
around me and beyond 

    

I am given too much work on a regular basis, which reduces the quality I 
can provide 

    

My supervisor brings out the best in me     

If I need guidance and support from my supervisor, he/she is seldom 
available to provide advice 

    

The information I receive about the Task performance allows me to 
accurately adjust my actions 

    

The level of performance expected of me for this Task, and how to 
achieve it is clear 

    

Feedback on this Task is given in time to allow me to make 
improvements 

    

Constructive feedback on how to get along with others is provided 
regularly 

    

Advice I receive on interactions with others indicates what is acceptable 
behavior 

    

Feedback is given in a timely manner to enable me to maintain 
acceptable behavior 

    

I find that the Task challenging and it maintains my interest     
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Human Resources Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions:  Read each statement carefully and place checkmark in column that represents your response.  If the 
statement does not apply to you, please leave the space blank. Thank you. 
    

Human Resources Questionnaire Disagree 
Slightly 

Disagree 
Agree 

Employees have Knowledge & Skills    

Employees have the necessary knowledge, skills and/or experience to do the Task    

Less training would be needed if more qualified candidates are hired    

Employees Job Satisfaction    

The number of employees leaving the organization is at the expected level    

The degree to which employees are dismissed has not changed appreciably    

Environment    

The number of new employees hired within the past year is higher than normal    

Recruitment    

Employees for this Task are hired internally by our organization    

Only individuals with required qualifications and experience are hired    
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Human Resource Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
 
Directions:   Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result in 
the corresponding field in the Root Cause Analysis (Section 4.4). 
     
     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

Employees have the necessary knowledge, skills and/or experience to 
do the Task 

8 1 1 Disagree 

Less training would be needed if more qualified candidates are hired     

The number of employees leaving the organization is at the expected 
level 

    

The degree to which employees are dismissed has not changed 
appreciably 

    

The number of new employees hired within the past year is higher than 
normal 

    

Employees for this Task are hired internally by our organization     

Only individuals with required qualifications and experience are hired     
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Subject Matter Expert Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions: Read each statement carefully and place checkmark in column that represents your response.  If the 
statement does not apply to you, please leave the space blank. Thank you. 

    

Subject Matter Expert Questionnaire Disagree 
Slightly 

Disagree 
Agree 

Tools    

Tools for Task are reliable, function properly and meet expectations    

One or more crucial pieces of equipment or material needed by employees to 
perform Task is missing  

   

Existing tools and materials permit personnel to meet performance objectives for 
Task 

   

Employees can easily and quickly locate all necessary tools and materials for Task     

Modernization of some equipment or materials would improve workmanship and 
Task productivity 

   

Employees Dependency on Tools    

Personnel need the equipment to perform the Task    

Tasks    

Errors in performing this Task among this group of employees will have serious 
consequences 

   

The Task level of complexity is considerably high, and mistakes can occur easily    

The Task or procedures carried out by employees can be greatly simplified    
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Subject Matter Expert Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
 
Directions:   Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result in 
the corresponding field in the Root Cause Analysis (Section 4.4). 

     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

Tools for Task are reliable, function properly and meet expectations 8 1 1 Disagree 

One or more crucial pieces of equipment or material needed by 
employees to perform Task is missing 

    

Existing tools and materials permit personnel to meet performance 
objectives for Task 

    

Employees can easily and quickly locate all necessary tools and 
materials for Task 

    

Modernization of some equipment or materials would improve 
workmanship and Task productivity 

    

Personnel need the equipment to perform the Task     

Errors in performing this Task among this group of employees will have 
serious consequences 

    

The Task level of complexity is considerably high, and mistakes can 
occur easily 

    

The Task or procedures carried out by employees can be greatly 
simplified 

    

 
 



Annex A: Data Collection Forms 
____________________________________________________________________________________________ 

 

83 | P a g e  
www.bnhexpertsoft.com  

Copyright © BNH Expert Software Inc. 
 
 
 

Supervisor Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions: Read each statement carefully and place checkmark in column that represents your response.  If the 
statement does not apply to you, please leave the space blank. Thank you. 
    

Supervisor Questionnaire Disagree 
Slightly 

Disagree 
Agree 

Employees Qualifications    

Task is performed by employees correctly most of the time    

In the past, Task was performed correctly by personnel most of the time    

Personnel know the procedures for optimal performance of Task    

Employees have the ability to perform Task to the expected standard    

Employees Awareness of Policies    

Personnel can list all policies and procedures related to the Task    

Personnel can explain the main ideas behind all policies and procedures relevant to 
the Task 

   

Employees can follow required policies and procedures correctly for Task    

Policies Impact    

Policies and procedures have minimal impact on how employees perform Task    

Employees Interpersonal Skills    

Delays in Task performance are mostly caused by other groups of employees    

Interpersonal relations among employees are entirely acceptable    

Personnel interpersonal relations have a significant impact on Task performance    

Employees Dependency on Tools    

Employees can only perform Task to desired standard if they have the required 
tools 

   

Employees can use the equipment and/or materials required for Task efficiently 
and effectively 
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Supervisor Questionnaire (continued) Disagree 
Slightly 

Disagree 
Agree 

Employees Incentives System    

Outstanding personnel performance is rewarded regularly    

Employees are informed of their poor performance and encouraged to improve    

Individuals or teams that complete their work in advance are given less rewarding 
Tasks 

   

Employees Job Satisfaction    

Employees are complaining that their responsibilities do not correspond to the job 
description 

   

Complacency is running high in the workplace, resulting in overall disenchantment    

Supervisors Awareness of Policies    

I can list all the policies and procedures that relate to the Task    

I can explain the meaning behind all policies and procedures relating to the Task    

I am able to use and apply all policies and procedures that impact the Task     

Implementing the performance related incentive system correctly is not a problem    

I find employees performance of the Task significantly less satisfactory than 
previous years 

   

I have full control of my operation with minimal problems, and an awareness of 
related projects 

   

There is a lack of time in order to properly address key tasks    
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Supervisor Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
Directions:   Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result in 
the corresponding field in the Root Cause Analysis (Section 4.4). 
     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

Task is performed by employees correctly most of the time 3 1 6 Agree 

In the past, Task was performed correctly by personnel most of the time     

Personnel know the procedures for optimal performance of Task     

Employees have the ability to perform Task to the expected standard     

Personnel can list all policies and procedures related to the Task     

Personnel can explain the main ideas behind all policies and procedures 
relevant to the Task 

    

Employees can follow required policies and procedures correctly for 
Task 

    

Policies and procedures have minimal impact on how employees 
perform Task 

    

Delays in Task performance are mostly caused by other groups of 
employees 

    

Interpersonal relations among employees are entirely acceptable     

Personnel interpersonal relations have a significant impact on Task 
performance 

    

Employees can only perform Task to desired standard if they have the 
required tools 

    

Employees can use the equipment and/or materials required for Task 
efficiently and effectively 

    

Outstanding personnel performance is rewarded regularly     

Employees are informed of their poor performance and encouraged to 
improve 

    

Individuals or teams that complete their work in advance are given less 
rewarding Tasks 

    

Employees are complaining that their responsibilities do not correspond 
to the job description 

    

Complacency is running high in the workplace, resulting in overall 
disenchantment 
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Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

I can list all the policies and procedures that relate to the Task     

I can explain the meaning behind all policies and procedures relating to 
the Task 

    

I am able to use and apply all policies and procedures that impact the 
Task 

    

Implementing the performance related incentive system correctly is not 
a problem 

    

I find employees performance of the Task significantly less satisfactory 
than previous years 

    

I have full control of my operation with minimal problems, and an 
awareness of related projects 

    

There is a lack of time in order to properly address key tasks     
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Instructor Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions: Read each statement carefully and place checkmark in column that represents your response.  If the 
statement does not apply to you, please leave the space blank. Thank you. 

    

Instructor Questionnaire Disagree 
Slightly 

disagree 
Agree 

Employees Interpersonal skills    

Employees are given adequate opportunities to learn interpersonal skills     

Tasks    

The training materials for these employees is less than one year    

Environment    

A new system or technology that impacts Task was introduced within the last 
twelve months 

   

Impact of new system or technology on Task is significant    

Formal training was given to personnel on how to successfully implement the new 
system 

   

New or improved work procedures that impact Task have been introduced within 
the past year 

   

Formal training was provided on how to apply the new work procedures    

Formal training was provided for new employees on how to perform the Task    
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Instructor Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
 
Directions:   Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result in the 
corresponding field in the Root Cause Analysis (Section 4.4). 

     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

Employees are given adequate opportunities to learn interpersonal 
skills 

8 1 1 Disagree 

The training materials for these employees is less than one year     

A new system or technology that impacts Task was introduced within 
the last twelve months 

    

Impact of new system or technology on Task is significant     

Formal training was given to personnel on how to successfully 
implement the new system 

    

New or improved work procedures that impact Task have been 
introduced within the past year 

    

Formal training was provided on how to apply the new work procedures     

Formal training was provided for new employees on how to perform 
the Task 
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Senior Executives Questionnaire 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 
Name (optional): _________________________________________ 

 
 
Directions: Read each statement carefully and place checkmark in column that represents your response. If the 
statement does not apply to you, please leave the space blank. Thank you. 

    

Senior Executives Questionnaire Disagree 
Slightly 

Disagree 
Agree 

Environment    

The unit/division effectively implements its strategic goals for these employees    

Too many changes are required to implement different procedures for a new 
system 

   

The unit/division has adapted quickly to changes in the work environment    

Employees Incentive System    

A formal performance based incentive system is available for this occupation    

Policies    

A detailed description of standards and policies for this Task is available    

Policies and procedures can easily be followed by employees to detect and correct 
skill gaps 

   

Rules and regulations must be strictly followed for employees to attain optimal 
productivity for Task 

   

A method or tool exists to accurately measure personnel Task performance    

The measurement of personnel proficiency in performing Task is reliable and 
consistent 

   

Guidelines for employees are obsolete or invalid, and they actually interfere with 
their performance 

   

Overlap in policies or procedures are contributing to delays    

Repetition in procedures are wasting time, money and resources    
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Senior Executives Questionnaire Summary 
 
 

Unit/Division: _________________________________________ 
Job (Occupation): _________________________________________ 
Task _________________________________________ 
Date: _________________________________________ 

 
 
Directions:   Tally the responses.  The Consensus should reflect the response with the highest value.  Input the result in 
the corresponding field in the Root Cause Analysis (Section 4.4). 
     

Summary of Responses 
# that 

Disagree 

# that 
Slightly 

Disagree 

# that 
Agree 

Consensus 

The unit/division effectively implements its strategic goals for these 
employees 

8 1 1 Disagree 

Too many changes are required to implement different procedures for a 
new system 

    

The unit/division has adapted quickly to changes in the work 
environment 

    

A formal performance based incentive system is available for this 
occupation 

    

A detailed description of standards and policies for this Task is available     

Policies and procedures can easily be followed by employees to detect 
and correct skill gaps 

    

Rules and regulations must be strictly followed for employees to attain 
optimal productivity for Task 

    

A method or tool exists to accurately measure personnel Task 
performance 

    

The measurement of personnel proficiency in performing Task is 
reliable and consistent 

    

Guidelines for employees are obsolete or invalid, and they actually 
interfere with their performance 

    

Overlap in policies or procedures are contributing to delays     

Repetition in procedures are wasting time, money and resources     

 
 
 

 


